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Preface
This guide contains instructions on how to install and configure the 
Advanced Control Suite software for the AT-2916SX and AT-2931SX 
Ethernet network adapters on Windows 2000, Windows 2003, and Linux 
platforms. For information about how to install the AT-2931SX and 
AT-2916 SX adapters as well as procedures to install and configure the 
related software, see the Gigabit Ethernet Network Adapters Installation 
Guide (part number 613-000049).

The Preface contains the following sections:

“Where to Find Web-based Guides” on page 10
“Contacting Allied Telesyn” on page 11
9
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Preface
Where to Find Web-based Guides

The installation and user guides for all Allied Telesyn products are 
available in portable document format (PDF) on our web site at 
www.alliedtelesyn.com. You can view the documents online or 
download them onto a local workstation or server.
10
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Contacting Allied Telesyn 

This section provides Allied Telesyn contact information for technical 
support as well as sales and corporate information. 

Online Support You can request technical support online by accessing the Allied Telesyn 
Knowledge Base: http://kb.alliedtelesyn.com. You can use the 
Knowledge Base to submit questions to our technical support staff and 
review answers to previously asked questions.

Email and
Telephone

Support

For Technical Support via email or telephone, refer to the Support & 
Services section of the Allied Telesyn web site: www.alliedtelesyn.com.

Returning
Products

Products for return or repair must first be assigned a return materials 
authorization (RMA) number. A product sent to Allied Telesyn without an 
RMA number will be returned to the sender at the sender’s expense.

To obtain an RMA number, contact Allied Telesyn Technical Support 
through our web site: www.alliedtelesyn.com.

Sales or
Corporate

Information

You can contact Allied Telesyn for sales or corporate information through 
our web site: www.alliedtelesyn.com. To find the contact information for 
your country, select Contact Us -> Worldwide Contacts.

Management
Software Updates

New releases of management software for our managed products are 
available from either of the following Internet sites:

Allied Telesyn web site: www.alliedtelesyn.com 
Allied Telesyn FTP server: ftp://ftp.alliedtelesyn.com 

If you prefer to download new software from the Allied Telesyn FTP server 
from your workstation’s command prompt, you will need FTP client 
software and you must log in to the server. Enter “anonymous” for the user 
name and your email address for the password.
11
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Chapter 1

Advanced Server Program Overview
This chapter provides an introduction to the Allied Telesyn Advanced 
Server Program and contains following sections:

“Broadcom Advanced Server Program (BASP) Overview” on page 14
“Broadcom Advanced Control Suite 2 (BACS 2) Features” on page 15
“BASP for Windows 2000 and Windows 2003” on page 16
“BASP for Linux” on page 17
13
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Chapter 1: Advanced Server Program Overview
Broadcom Advanced Server Program (BASP) Overview

BASP is an intermediate software driver for Windows Server 2003, 
Windows 2000, and Linux that provides load-balancing, fault-tolerance, 
and VLAN features. 

The BASP features are provided by creating teams (virtual adapters) that 
consist of multiple NIC interfaces. A team can consist of one to eight NIC 
interfaces. You can designate each interface as a primary or standby* 
interface. All primary interfaces in a team participate in Load-balancing 
operations by sending and receiving a portion of the total traffic. Standby 
interfaces take over in the event that all primary interfaces have lost their 
links. VLANs can be added to a team to allow multiple VLANs with 
different VLAN IDs. A virtual adapter is created for each VLAN added. 
Load-balancing and fault-tolerance features work with any third party's 
NIC adapters, but are only supported with the Allied Telesyn Gigabit 
Ethernet adapters. VLANs only work with the Allied Telesyn Gigabit 
Ethernet adapters. 

Note
*You can use Standby only in Smart Load-Balance mode (see 
Limitations below).

Smart Load-balance (SLB) mode works with all Ethernet switches without 
configuring the switch ports to any special trunking mode. Only IP traffic is 
load-balanced in both inbound and outbound directions. In comparison, 
IPX traffic is load-balanced in the outbound direction only. Other protocol 
packets are be sent and received through one primary NIC only. Fault-
tolerance for non-IP traffic is only supported using the Allied Telesyn 
Gigabit Ethernet adapters. The Generic Trunking mode requires the 
Ethernet switch to support some form of port trunking mode (for example, 
Cisco's Gigabit EtherChannel or other switch vendor's link aggregation 
mode). This mode is protocol-independent and all traffic should be load-
balanced and fault-tolerant.

Note
Allied Telesyn recommends that you disable the spanning tree 
protocol at the switch when you use BASP. This setting minimizes 
the downtime due to spanning tree loop determination when failing 
over. 

Note
The Broadcom Advanced Server Program (BASP) requires that at 
least one adapter in the team be an Allied Telesyn Gigabit Ethernet 
adapters.
14
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Broadcom Advanced Control Suite 2 (BACS 2) Features

The Broadcom Advanced Control Suite 2 (BACS 2) is a graphical user 
interface with the following functions. (See Chapter 2, “Broadcom 
Advanced Control Suite 2 (BACS 2) Applications” on page 19 for 
additional information.) 

Vital Sign – The Vital Sign screen allows you to view vital adapter 
information, network status, and network connectivity. Active Adapters 
are listed.
Resources – Shows the system resources of the selected device.
Hardware – Shows the hardware information (the ASIC version and 
the firmware version) for the selected device.
Network Test – The Network Test screen allows you to verify IP 
network connectivity. This test verifies if the NDIS driver is installed 
correctly. Also, it tests connectivity to a gateway or other specified IP 
address on the same subnet.
Diagnostics – The Diagnostics screen allows you to view information 
about adapters. This function is used to test the network interface card.
Configuration – Sets configuration options (NIC Battery Saving Mode, 
for example).
Statistics – The Statistics screen allows you to view traffic statistics for 
the Allied Telesyn Gigabit Ethernet adapters as well as adapters from 
other vendors. Statistical values and coverage is more comprehensive 
for the Allied Telesyn Gigabit Ethernet adapters.
Load Balance/Virtual LAN – The Load Balance/Virtual LANs screen 
allows you to configure advanced features. You can configure any 
available adapter as part of a team. 
15
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BASP for Windows 2000 and Windows 2003

The following options are supported under Windows 2000 and Windows 
2003. For additional information, see Chapter 3, “Installing BACS on 
Windows 2000 and Windows 2003 Systems” on page 63.

Failover and
Load Balance

Adapter teaming for failover 
Smart Load Balance™ 
Smart Load Balance (auto-failback disable) 
Generic Link Aggregation (GEC/FEC, Open trunk) 
Link aggregation (IEEE 802.3ad) 

Virtual LAN
(VLANs)

Up to 64 VLANs (63 tagged and 1 untagged) per adapter using IEEE 
802.1Q-1988 tagging. VLANs are supported only on the Allied Telesyn 
Gigabit Ethernet adapters. 
16

Download from Www.Somanuals.com. All Manuals Search And Download.



Advanced Control Suite User’s Guide
BASP for Linux

The following options are supported under Linux. For additional 
information, see Chapter 4, “Installing BACS on a Linux System” on page 
67.

Failover and
Load Balance

SLB mode requires NICE drivers and works with all Ethernet switches 
without configuring the switch ports to any special trunking mode. Only 
IP traffic is load-balanced in both inbound and outbound directions. 
Generic trunking mode does not require NICE and can work with any 
NIC; however, it requires the Ethernet switch to support the technology 
and be properly configured. This mode is protocol-independent and all 
traffic should be load-balanced and fault-tolerant.
802.3ad mode requires NICE drivers and Ethernet switches supporting 
IEEE 802.3ad Link Aggregation. This mode is protocol-independent 
and all traffic should be load-balanced and fault-tolerant. All the 
physical interfaces in the 802.3ad teams are defaulted to be LACP 
active. A 802.3ad team requires all the member NICs support NICE. 
All the member NICs, once in the 802.3ad team, will be set with the 
same MAC address. 

Virtual LAN
(VLAN)

You can add VLANs to a team to allow multiple VLANs with different 
VLAN IDs. A virtual device is created for each VLAN added. 
17
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Chapter 2

Broadcom Advanced Control Suite 2 
(BACS 2) Applications
This chapter describes the Broadcom Advanced Control Suite 2 (BACS 2) 
applications and contains the following sections:

“Overview” on page 20
“Installing the BACS 2 Application” on page 23
“Managing the BACS Application” on page 25
“Configuring the BACS 2 Application” on page 27
“Configuring Teaming” on page 42

Note
There are two BACS 2 versions. One is a 32-bit version located in 
/BACS/IA32 for standard (32-bit) Windows 2000/2003 operating 
systems. The other is a 64-bit version located in /BACS/x64 for 
Windows 2003 64-bit operating systems.
19
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Chapter 2: Broadcom Advanced Control Suite 2 (BACS 2) Applications
Overview 

The Broadcom Advanced Control Suite 2 (BACS 2) application is an 
integrated application (with a graphical user interface) that provides useful 
information about each network adapter that is installed in your computer. 
The BACS application also enables you to perform detailed tests, 
diagnostics, and analyses on each adapter, as well as view traffic 
statistics and set configuration options for each adapter, as shown in 
Figure 1. The BACS application is designed to run on the Windows 2000 
and Windows 2003 operating systems.

The Broadcom Advanced Server Program (BASP) application, which runs 
within BACS, is used to configure load balancing, fault tolerance, and 
virtual local area networks (VLANs). This application is available only on 
computers that use more than one network adapter.

Figure 1. Advanced Control Suite 2 Menu
20
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Information
Provided by the

BACS 2
Applications

The Broadcom Advanced Control Suite 2 lists all of the network adapters 
in your computer and provides the following information, if available, about 
each device, as shown in Table 1.

BACS 2 Features The following features are accessible from the BACS 2 application:

“Vital Sign Tab” on page 27. Provides at-a-glance status reports on all 
of the LAN devices in your computer.
“Resources Tab” on page 30. Displays the system resources of the 
selected device.
“Hardware Tab” on page 31. Displays the hardware information (the 
ASIC version and the firmware version) for the selected device.
“Advanced Tab” on page 32. Allows you to change the advanced 
properties.
“Network Test Tab” on page 35. Confirms network connectivity to a 
remote station. The network test sends ICMP packets to remote 
systems and waits for a response. If a gateway is configured, the test 
automatically sends packets to that system. If a gateway is not 
configured or if the gateway is unreachable, the test prompts you for a 
destination IP address.
“Diagnostics Tab” on page 36. Performs comprehensive diagnostics 
on Broadcom network adapters.
“Statistics Tab” on page 38. Provides detailed performance statistics 
on each selected device.

Table 1. BACS Application Information

Driver Status Driver Version Frames Rx OK 

MAC Address Driver Date Team Name 

Link Status Firmware Version Team Type 

IP Address ASIC Version VLAN Name 

Memory Address Bus Type VLAN ID 

Physical Address Bus No. BASP Tx Packet 

Speed Device No. BASP Tx Packet 
Discarded 

Duplex Function No. BASP Tx Packet 
Queried 

Slot No. Interrupt Request BASP Rx Packet 

Driver Name Frames Tx OK BASP Rx Packet 
Discarded 
21
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“BASP Statistics Tab” on page 41. Configures the load balance and 
failover by grouping multiple network adapters.
22
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Installing the BACS 2 Application

You can install the BACS 2 software through the GUI or by using the silent 
install option. See the following procedures:

“Installing Using the GUI,”  next
“Using Silent Installation” on page 23

Note
Before installing the BACS 2 software on a computer running 
Windows 2000 Advanced Server with Terminal Services, type 
change user /install from the DOS command prompt.

Installing Using
the GUI

To install the BACS 2 application using the GUI (graphical user interface), 
perform the following procedure.

Note
Before you begin the installation, close all applications, windows, 
and dialog boxes

1. Double-click setup.exe in the appropriate directory (IA32 or x64).

2. Click Next in Broadcom Management Programs Setup. 

3. Read the license agreement and click Yes. 

4. In Select Components, click the component you want to install: 

Control Suite. Installs the Broadcom Advanced Server Control 
Suite.
BASP. Installs the Broadcom Advanced Server Program.

5. Follow the on-screen instructions. 

You can start the Control Suite from the Control Panel by double-clicking 
Broadcom Control Suite 2. Or, click Start, point to Programs, point to 
Broadcom, and then click the Broadcom Advanced Control Suite 2.

Using Silent
Installation

The recommended installation procedure is to copy the installation files to 
your hard disk before you run the silent install because the setup /s 
command automatically generates a Setup.log file in the directory where it 
is run. 
23
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Note
Before you begin the installation, close all applications, windows, 
and dialog boxes.

1. Type setup /s and press ENTER. 
24
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Managing the BACS Application

This section contains the following procedures for managing the BACS 
application:

“Initializing the BACS 2 Application,”  next
“Updating the BACS Application” on page 25
“Removing the BACS Application” on page 25

Initializing the
BACS 2

Application

To initialize the BACS 2 application on your computer, perform the 
following procedure.

1. In the Control Panel, double-click Broadcom Control Suite 2. 

Or, click Start, point to Programs, point to Broadcom, and then click 
Broadcom Advanced Control Suite 2.

Note
You must install the Allied Telesyn adapters before you initialize the 
BACS application.

Updating the
BACS

Application

To update the BACS application on your computer, perform the following 
procedure.

Note
Before you begin the update, close all applications, windows, and 
dialog boxes.

1. Double-click Setup.exe. 

2. Click Next in Broadcom Management Programs Setup. 

3. Read the license agreement and click Yes. 

4. In Select Components, click the component you want to install: 

Control Suite. Installs the Broadcom Advanced Server Control 
Suite.
BASP. Installs the Broadcom Advanced Server Program.

5. Follow the on-screen instructions.

Removing the
BACS

Application

To remove the BACS application from your computer, perform the 
following procedure.

1. In the Control Panel, double-click Add/Remove Programs. 
25
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2. Click Broadcom Management Programs and click Change/Remove 
(Windows XP) or Add/Remove (Windows 2000). 

3. Click Next. 

4. In InstallShield Wizard, click Remove, and then click Next. 

5. Click OK to remove the application and all of its components. 

6. Click OK. 

7. Restart your computer. 
26
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Configuring the BACS 2 Application

Start the BACS application and then click the tab on Broadcom 
Advanced Control Suite 2 that provides the information of interest or 
access to the tests, diagnostics, analyses, and configuration functions you 
want to perform. Or, on the Tools menu, click Create a Team to start the 
BASP application. Select from the following tabs:

“Vital Sign Tab” on page 27
“Resources Tab” on page 30
“Hardware Tab” on page 31
“Advanced Tab” on page 32
“Network Test Tab” on page 35
“Diagnostics Tab” on page 36
“Statistics Tab” on page 38
“BASP Statistics Tab” on page 41

Vital Sign Tab The Vital Sign tab contains information about the adapter and other 
network adapters that are installed, the link status of the network, and 
network connectivity. To view this information for any installed network 
adapter, click the name of the device, as shown in Figure 2 on page 28.
27
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Note
Information about network adapters made by other vendors is less 
comprehensive than the information provided about the Allied 
Telesyn AT-2916 and AT-2931 adapters or other Broadcom-based 
adapters.

Figure 2. Vital Sign Tab

The Vital Sign Tab contains the following fields:

MAC Address. This address can either be the permanent MAC 
address or an address assigned by the Locally Administered Address 
in the Advanced properties tab.
Permanent MAC Address. This is a physical MAC (media access 
control) address that is assigned to the device by the manufacturer. 
The physical address cannot be all 0s.
IP Address. The network address that is associated with the device. If 
the IP address is all 0’s, the associated driver has not been bound with 
the Internet Protocol (IP).
Driver Status. Information about the status of the driver that is 
associated with the selected controller.

–  Driver Loaded. Normal operating mode. The driver that is 
associated with the device has been loaded by Windows 
and is functioning.

–  Driver Not Loaded. The driver that is associated with the 
28
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device has not been loaded by Windows.

–  Information Not Available. The value is not obtainable 
from the driver that is associated with the device.

Driver Name/Version/Date. The file name, version, and creation date 
of the software driver that is associated with the device.
Offload Capabilities. The options are:

–  LSO (Large Send Offload). The network adapter performs 
TCP segmentation.

–  CO (Checksum Offload). The adapter computes the TCP/
IP checksum.

BASP State. Information about the status of the BASP application. 
This information is displayed only when there is a team. See 
“Configuring Teaming” on page 42
Network Status: The following network status information is provided:

–  Link Status. The indicator is green if a link is established. 
A red indicator means that a link is not established.

–  Speed. The link speed of the device.

–  Duplex. The duplex mode in which the device is operating.
29
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Resources Tab This section describes the Resources tab, as shown in Figure 3.

Figure 3. Resources Tab 

The Resources tab contains the following fields:

Bus Type. Indicates the PCI bus type (PCI or PCI-X).
Slot No. Indicates the PCI slot number of the installed adapter.
Bus Speed (MHz). Indicates the PCI bus speed (33, 66, 100, or 133 
MHz).
Bus Width (bit). Indicates the PCI bus data width of either 32 or 64 
bits.
Bus No. Indicates the PCI bus number and the device number for the 
device. 

Example: [0] 14 indicates that the controller resides in PCI bus 0, 
device 14.

Device No. The number assigned to the device by the operating 
system.
Function No. The port number of the adapter. For a single-port 
adapter, the function number is 0. For a two-port adapter, the function 
number for the first port is 0, and the function number for the second 
port is 1.
Interrupt Request. The interrupt line number that is associated with 
the device. Valid numbers range from 2 to 25. 
Memory Address. The memory mapped address that is assigned to 
the device. This value can never be 0.
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Hardware Tab This section provides a description of the Hardware tab, as shown in 
Figure 4.

Figure 4. Hardware Tab

The Hardware tab contains the following fields:

ASIC Version. The chip version of the adapter. This information is not 
available for devices made by other vendors.
Firmware Version. The firmware version of the adapter. This 
information is not available for devices made by other vendors.
Vendor ID. A unique vendor ID that is registered by the PCI-SIG 
organization.
Device ID. A unique device ID that is registered by Broadcom.
Subsystem Vendor ID. A unique vendor ID that is registered by the 
PCI-SIG organization.
Subsystem ID. A unique ID registered by Allied Telesyn, Inc.
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Advanced Tab This section describes the Advanced tab, as shown in Figure 5

Figure 5. Advanced Tab

The Advanced tab contains the following fields:

802.1p QOS. The 802.1p QOS property enables quality of service, 
which is an Institute of Electrical and Electronics Engineering (IEEE) 
specification that treats different types of network traffic differently to 
ensure required levels or reliability and latency according to the type of 
traffic. This property is disabled by default. Unless the network 
infrastructure supports QoS, do not enable QoS. Otherwise, problems 
may occur.
Checksum Offload. Normally the Checksum Offload function is 
computed by the protocol stack. When you select one of the 
Checksum Offload property values (other than None), the checksum 
can be computed by the network adapter.

–  Rx TCP/IP Checksum. Enables receive TCP, IP, and UDP 
checksum offloading.

–  Tx TCP/IP Checksum. Enables transmit TCP, IP, and UDP 
checksum offloading.

–  TX/Rx TCP/IP Checksum (default). Enables transmit and 
receive TCP, IP, and UDP checksum offloading.

–  None. Disables checksum offloading.

Ethernet@WirespeedTM. The Ethernet@Wirespeed property enables 
a Gigabit Ethernet adapter to establish a link at a lower speed when 
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only 2 pairs of wires are available in the cabling plant. By default, this 
property is set to Enable. To disable Ethernet@Wirespeed, change the 
setting to Disable.

Note
This parameter is available only for copper devices and is not 
displayed for the AT-2916SX and AT-2931SX adapters.

–  Disable. Disables Ethernet@Wirespeed.

–  Enable (default). Enables Ethernet@Wirespeed

Flow Control. The Flow Control property enables or disables the 
receipt or transmission of PAUSE frames. PAUSE frames enable the 
network adapter and a switch to control the transmit rate. The side that 
is receiving the PAUSE frame momentarily stops transmitting.

–  Auto (default). PAUSE frame receipt and transmission are 
optimized. 

–  Disable. PAUSE frame receipt and transmission are 
disabled. 

–  Rx PAUSE. PAUSE frame receipt is enabled. 

–  Rx/Tx PAUSE. PAUSE frame receipt and transmission are 
enabled. 

–  Tx PAUSE. PAUSE frame transmission is enabled.

Jumbo Mtu. The Jumbo Mtu property allows the network adapter to 
transmit and receive oversized Ethernet frames that are greater than 
1514 bytes, but less than 9000 bytes in length. This property requires 
the presence of a switch that is able to process Jumbo frames. 

Frame size is set at 1500 bytes by default. To increase the size of the 
received frames, increment the byte quantity in 500-byte increments.

Large Send Offload. Normally the TCP segmentation is done by the 
protocol stack. When you enable the Large Send Offload property, the 
TCP segmentation can be done by the network adapter. 

–  Disable. Disables Large Send Offload.

–  Enable. (default). Enables Large Send Offload.

Locally Administered Address. The Locally Administered Address is 
a user-defined MAC address that is used in place of the MAC address 
originally assigned to the network adapter. Every adapter in the 
network must have its own unique MAC address. This locally 
administered address consists of a 12-digit hexadecimal number.
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–  Value. Assigns a unique node address for the adapter.

–  Not Present (Default). Uses the factory-assigned node 
address on the adapter. 

The appropriate assigned ranges and exceptions for the locally 
administered address include the following:

* The range is 0000 0000 0001 to FFFF FFFF FFFD. 

* Do not use a multicast address (least significant bit of the high 
byte = 1). 

* Do not use all 0s or all F's. 

Speed & Duplex. The Speed & Duplex property sets the connection 
speed and mode to that of the network. Note that Full-Duplex mode 
allows the adapter to transmit and receive network data 
simultaneously. 

Note
This parameter is available only for copper devices and is not 
displayed for the AT-2916SX and AT-2931SX adapters.

–  10 Mb Full. Sets the speed at 10 Mbit/s and the mode to 
Full-Duplex.

–  10 Mb Half. Sets the speed at 10 Mbit/s and the mode to 
Half-Duplex. 

10 Mb Half and 100 Mb Half settings force the network adapter to 
connect to the network in Half-Duplex mode. The network adapter 
may not function if the network is not configured to operate at the 
same mode. 

–  100 Mb Full. Sets the speed at 100 Mbit/s and the mode to 
Full-Duplex. 

–  100 Mb Half. Sets the speed at 100 Mbit/s and the mode to 
Half-Duplex. 

10 Mb Full and 100 Mb Full settings force the network adapter to 
connect to the network in Full-Duplex mode. The network adapter 
may not function if the network is not configured to operate at the 
same mode. 

–  Auto (default). Sets the speed and mode for optimum 
network connection (recommended). This setting allows 
the network adapter to dynamically detect the line speed of 
the network. Whenever the network capability changes, the 
network adapter automatically adjusts to the new line 
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speed and duplex mode. A speed of 1 Gbit/s is enabled by 
selecting Auto, when that speed is supported. 

Wake Up Capabilities. The Wake Up Capabilities property enables 
the network adapter to wake up from a low-power mode when it 
receives a network wake-up frame. Two types of wake-up frames are 
possible: Magic Packetô and Wake Up Frame. 

Note
This parameter is available only for copper devices and is not 
displayed for the AT-2916SX and AT-2931SX adapters.

–  Both (default). Selects both Magic Packet and Wake Up 
Frame as wake-up frames. 

–  Magic Packet. Selects Magic Packet as the wake-up 
frame. 

–  None. Selects no wake-up frame. 

–  Wake Up Frame. Selects Wake Up Frame as the wake-up 
frame and allows the network adapter to wake the system 
when an event such as a ping or an Address Resolution 
Protocol (ARP) request is received. 

WOL Speed. The WOL Speed property sets the speed at which the 
network adapter connects to the network while the network adapter is 
in Wake on LAN mode. By default, the WOL Speed property is set to 
Auto.

Note
This parameter is available only for copper devices and is not 
displayed for the AT-2916SX and AT-2931SX adapters.

–  10 Mb. Sets the speed to 10 Mbit/s. This is the network 
speed when the system is in a standby mode awaiting a 
wake-up frame.

–  100 Mb. Sets the speed to 100 Mbit/s.

–  Auto (default). Sets the speed for optimum network 
connection.

Network Test
Tab

In the Network Test tab, you can verify IP network connectivity. This test 
verifies if the driver is installed correctly and tests connectivity to a 
gateway or other specified IP address on the same subnet. The Network 
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test uses TCP/IP, as shown in Figure 6.

Figure 6. Network Test Tab

Diagnostics Tab On the Diagnostics tab you can perform diagnostic tests on Allied Telesyn 
network adapters. You use this function to test the physical components of 
the adapter, as shown in Figure 7 on page 37.
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Note
The network connection is temporarily lost when the diagnostic tests 
are running.

Figure 7. Diagnostics Tab

The Diagnostics tab contains the following fields:

Control Registers. This test verifies the read and write capabilities of 
the network controller registers by writing various values to the 
registers and verifying the results. The device driver uses these 
registers to perform network functions such as sending and receiving 
information. If the test fails, the device may not work properly. 
MII Registers. This test verifies the read and write capabilities of the 
registers of the physical layer (PHY). This field is not displayed for fiber 
adapters.
EEPROM. This test verifies the content of the electrically erasable 
programmable read-only memory (EEPROM) by reading a portion of 
the EEPROM and computing the checksum. The test fails if the 
computed checksum is different from the checksum stored in the 
EEPROM. An EEPROM image upgrade does not require a code 
change for this test. 
Internal Memory. This test verifies that the internal memory of the 
device is functioning properly. The test writes patterned values to the 
memory and reads back the results. The test fails if an erroneous value 
is read back. The device cannot function without its internal memory. 
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On-Chip CPU. This test verifies the operation of the internal CPUs in 
the device. 
Interrupt. This test verifies that the NDIS driver is able to receive 
interrupts from the device. 
Loopback MAC. This test verifies that the Network Device Driver 
Interface Specification (NDIS) driver is able to send packets to and 
receive packets from the network microcontroller. 
Loopback PHY. This test verifies that NDIS is able to send packets to 
and receive packets through the network microcontroller and the 
integrated PHY chip.
Test LED. This test causes all of the LEDs to blink 5 times for the 
purpose of identifying the device. 

Statistics Tab On the Statistics Tab, shown in Figure 8, you can view traffic statistics for 
both Allied Telesyn network devices and network devices made by other 
vendors. Statistical information and coverage are more comprehensive for 
the Allied Telsyn adapters.

Note
If an adapter is disabled, team statistics are not displayed.

Figure 8. Statistics Tab
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General Statistics

Definitions of the general statistics parameters are provided below.

Frames Tx OK. A count of frames that are successfully transmitted. 
This counter is incremented when the transmit status is reported as 
Transmit OK.
Frames Rx OK. A count of frames that are successfully received 
(Receive OK). This does not include frames received with frame-too-
long, frame check sequence (FCS), length or alignment errors, or 
frames lost due to internal MAC sublayer errors. This counter is 
incremented when the receive status is reported as Receive OK.
Directed Frames Tx. A count of directed data frames that are 
successfully transmitted.
Multicast Frames Tx. A count of frames that are successfully 
transmitted (as indicated by the status value Transmit OK) to a group 
destination address other than a broadcast address.
Broadcast Frames Tx. A count of frames that were successfully 
transmitted (as indicated by the transmit status Transmit OK) to the 
broadcast address. Frames transmitted to multicast addresses are not 
broadcast frames and, therefore, are excluded.
Directed Frames Rx. A count of directed data frames that are 
successfully received.
Multicast Frames Rx. A count of frames that are successfully 
received and are directed to an active nonbroadcast group address. 
This does not include frames received with frame-too-long, FCS, 
length errors, alignment errors, or frames lost due to internal MAC 
sublayer errors. This counter is incremented as indicated by the 
Receive OK status.
Broadcast Frames Rx. A count of frames that are successfully 
received and are directed to a broadcast group address. This count 
does not include frames received with frame-too-long, FCS, length 
errors, alignment errors, or frames lost due to internal MAC sublayer 
errors. This counter is incremented as indicated by the Receive OK 
status.

IEEE 802.3 Statistics 

Definitions of the IEEE 802.3 statistics parameters are provided below.

Frames Rx with Alignment Error. A count of frames that are not an 
integral number of octets in length and do not pass the FCS check. 
This counter is incremented when the receive status is reported as 
Alignment Error.
Frames Tx with one Collision. A count of frames that are involved in 
a single collision and are subsequently transmitted successfully. This 
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counter is incremented when the result of a transmission is reported as 
Transmit OK and the attempt value is 2.
Frames Tx with more than one Collision. A count of frames that are 
involved in more than one collision and are subsequently transmitted 
successfully. This counter is incremented when the transmit status is 
reported as Transmit OK, and the value of the attempts variable is 
greater than 2 and less or equal to the attempt limit.
Frames Tx after Deferral. A count of frames whose transmission was 
delayed on the first attempt because the medium was busy. The 
frames involved in any collision are not counted.

Custom Statistics

Definitions of the custom statistics parameters are provided below.

Note
Custom statistics are available only for an enabled adapter.

Number of Interrupts generated by this adapter. The number of 
interrupts generated by the device.
Number of Interrupts avoided by this adapter. The number of 
interrupts avoided by the device.
Tx Max Coalesce Frames Threshold hit. The number of times the 
Send Max Coalesce Frames Threshold was hit.
Rx Max Coalesce Frames Threshold hit. The number of times the 
Receive Max Coalesce Frames Threshold was hit.
DMA write Queue was full. The number of times the DMA write 
queue was full.
DMA write High Priority Queue was full. The number of times the 
DMA write high priority queue was full.
DMA Read Queue was full. The number of times the DMA read 
queue was full.
DMA Read High Priority Queue was full. The number of times the 
DMA read high priority queue was full.
Send Data Completion FTQ was full. The number of times the send 
data completion FTQ (flow through queue) was full.
NIC ran out of the Recv Buffer. The number of times the network 
adapter ran out of the Recv Buffer descriptors.
Frames size less than 64-byte with bad FCS. The number of frames 
with a size less than 64 bytes with bad FCS.
MAC Rx w/ Pause Command and Length = 0. MAC control frames 
with the pause command and a length equal to 0.
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MAC Rx w/ Pause Command and Length greater than 0. MAC 
control frames with the pause command and a length greater than 0.
MAC Rx w/ no Pause Command. MAC control frames with no pause 
command.
MAC Sent X-on. MAC Transmit with X-on was on.
MAC Sent X-off. MAC Transmit with X-on was off.

BASP Statistics
Tab

On the BASP Statistics tab you can view performance information about 
the network adapters that are on a team. To view this information for any 
team member adapter, click the name of the device. To view the BASP 
statistics for the team as a whole, click the name of the team, as shown in 
Figure 9.

Note
To see the BASP Statistics Tab, you must have a team.

Figure 9. BASP Statistics Tab

The BASP Statistics tab contains the following fields:

Tx. Packet. ???????
Tx. Packet Queued. ???????
Rx. Packet. ???????\
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Configuring Teaming

The teaming function allows you to group available network devices 
together to function as a team. Teaming is a method of creating a virtual 
LAN (a group of multiple devices that function as a single device). The 
benefit of this approach is that it enables load balancing and failover. You 
use BASP to set up teaming. For more information about BASP, see 
“Overview” on page 20.

Note
BASP is available only on computers that use at least one Allied 
Telesyn Gigabit Ethernet adapter or other Broadcom NetXtreme 
devices.

An example of teaming is shown in Figure 10. This example shows three 
network adapters in the Available Adapters list. When these adapters are 
moved to the Load Balance Members list, they function as a single 
adapter—that is, each member shares the traffic burden.

Figure 10. New Team Configuration Window

There are four types of load balance teams:

Smart Load Balance and Failover. In this type of team, a standby 
member handles the traffic if all of the load balance members fail (a 
failover event). All load balance members have to fail before the 
standby member takes over. When one or more of the load balance 
members is restored (fallback), the restored team member(s) resumes 
the handling the traffic.
42

Download from Www.Somanuals.com. All Manuals Search And Download.



Advanced Control Suite User’s Guide
Link Aggregation. In this type of team, you can dynamically configure 
the network adapters that have been selected to participate in a given 
team. If the link partner is not correctly configured for IEEE 802.3ad 
link configuration, errors are detected and noted. All adapters in the 
team are configured to receive packets for the same MAC address. 
The outbound load balancing scheme is determined by the BASP 
driver. The team’s link partner determines the load balancing scheme 
for inbound packets. In this mode, at least one of the link partners must 
be in active mode.
Generic Trunking. This type of team is very similar to the Link 
Aggregation type in that all of the adapters in the team need to be 
configured to receive packets for the same MAC address. However, 
this mode, does not provide Link Aggregation Control Protocol (LACP) 
or marker protocol support. This mode supports a variety of 
environments where the link partners are statically configured to 
support a proprietary trunking mechanism. Generic trunking supports 
load balancing and failover for both outbound and inbound traffic. 
SLB (Auto-Fallback Disable). This team is identical to Smart Load 
Balance and Failover, with the following exception—when the standby 
member is active, if a primary member comes back on line, the team 
continues using the standby member instead of switching to the 
primary member. This type of team is supported only for situations in 
which the network cable is disconnected and reconnected to the 
network adapter. It is not supported when the adapter is removed or 
installed via the Device Manager or a Hot-Plug PCI application.

Creating a Team
Using the Wizard

To create a team using the wizard, perform the following procedure.

1. From the Tools menu, click Create a Team.
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The Welcome page of the Broadcom Teaming Wizard is shown in 
Figure 11.

Figure 11. Broadcom Teaming Wizard Welcome Page

2. Click Next.

The Team Name page asks for a name for the team, as shown in 
Figure 12.

Figure 12. Team Name Page
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Note
The number of characters that can be used in a team name is a 
minimum of 1 and a maximum of 39. 

Note
A team name cannot begin with spaces or contain the character "&". 

Note
Team names must be unique. If you attempt to use a team name 
more than once, an error message appears indicating that the name 
already exists. 

Note
The maximum number of members in a team is 8. 

Note
When team configuration has been correctly performed, a Virtual 
Team adapter driver is created for each configured team. 

3. Type a name for the team and click Next.

The Team Type page, shown in Figure 13, asks you to choose what 
type of team you want to create.

Figure 13. Team Type Page

The options are: 
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Smart Load Balancing and Failover. In this type of team, a standby 
member handles the traffic if all of the load balance members fail (a 
failover event). All load balance members have to fail before the 
standby member takes over. When one or more of the load balance 
members is restored (fallback), the restored team member(s) resumes 
the handling the traffic.
802.3ad Link Aggregation using Link Aggregation Control 
Protocol (LACP). In this type of team, you can dynamically configure 
the network adapters that have been selected to participate in a given 
team. If the link partner is not correctly configured for IEEE 802.3ad 
link configuration, errors are detected and noted. All adapters in the 
team are configured to receive packets for the same MAC address. 
The outbound load balancing scheme is determined by the BASP 
driver. The team’s link partner determines the load balancing scheme 
for inbound packets. In this mode, at least one of the link partners must 
be in active mode.
FEC/GEC Generic Trunking. This type of team is very similar to the 
Link Aggregation type in that all of the adapters in the team need to be 
configured to receive packets for the same MAC address. However, 
this mode, does not provide Link Aggregation Control Protocol (LACP) 
or marker protocol support. This mode supports a variety of 
environments where the link partners are statically configured to 
support a proprietary trunking mechanism. Generic trunking supports 
load balancing and failover for both outbound and inbound traffic. 

4. Select the team type you want to use and click Next.

The Assigning Team Members page asks you to specify which 
adapters you want to include in the team, as shown in Figure 14.

Figure 14. Assigning Team Members Page
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5. Add or remove team members from the Available Adapters list to the 
Team members list, as shown in Figure 15, until you have all the 
members of the team identified.

Figure 15. Team Member Selection

6. Click Next.

The Designating a Standby Member page asks if you want to identify a 
standby member of the team, as shown in Figure 16.

Figure 16. Team Standby Member Page

The options are:

Do not configure a standby member
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Use the following member as a standby member
Enable Auto-Fallback Disable Mode. When this option is 
enabled, a standby member handles the traffic if all of the load 
balance members fail (a failover event). All load balance members 
have to fail before the standby member takes over. When one or 
more of the load balance members is restored (fallback), the 
restored team member(s) resumes the handling the traffic.

7. If you want a standby member, click Use the following member as a 
standby member and select one from the list, as shown in Figure 17.

Figure 17. Standby Member Selection

8. Click Next.

The Configuring LiveLink page asks if you want to configure LiveLink, 
as shown in Figure 18.
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Figure 18. Configuring LiveLink Page

The options are:

Yes. When you select this option, another page opens where you 
configure this feature.
No. This option does not allow you to configure LiveLink. This is 
the default and the setting that Allied Telesyn recommends.

9. Click Next.

The Configure VLAN Support page, as shown in Figure 19, allows you 
to create a VLAN.

Figure 19. Configure VLAN Support Page
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The options are:

Yes. Allows you to configure a VLAN. Proceed to step 10.
No. Skips the VLAN creation process. Proceed to step 13.

10. Click Next.

The VLAN Naming page, as shown in Figure 20, asks for a name for 
the VLAN.

Figure 20. VLAN Naming Page

11. Enter a name for the VLAN and click Next.

The VLAN Tagging page, as shown in Figure 21, asks you to specify 
the VLAN type. 
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Figure 21. VLAN Tagging Page

The options are:

Untagged. This option does not insert a VLAN tag ID into the 
Ethernet packet, but relies on the switch configuration for VLAN 
membership.
Tagged. This option inserts the VLAN tag ID into the Ethernet 
packet to identify its VLAN ID or membership.

12. Select Untagged or Tagged and click Next.

The Additional VLANs page, as shown in Figure 22, asks if you want to 
create additional VLANs. 
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Figure 22. Additional VLANs Page

13. Click Yes if you want to create more VLANs and you will be repeating 
steps 11 and 12. or No if you do not want to create another VLAN.

When you click No, the final wizard page is displayed, as shown in 
Figure 23.

Figure 23. Final Teaming Wizard Page

14. Select one of the following:

Commit changes and return to Broadcom Advanced Control 
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Suite 2. A warning message is displayed, as shown in Figure 24.

Figure 24. Commit Changes Warning Message

Click Yes to complete the process and return to the Broadcom 
Advanced Control Suite main window, or No to not save the 
changes.

Preview changes in Broadcom Advanced Control Suite 2. This 
option shows the Team Properties tab where you can verify that 
the settings are correct for the named team, as shown in Figure 25.

Figure 25. Team Properties Tab

Review your changes and click Apply to complete the process and 
return to the Broadcom Advanced Control Suite 2 main window.

Creating a Team
Using the Expert

Mode

To create a team, perform the following procedure.

1. From the Tools menu, click Create a Team.
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The Welcome page of the Broadcom Teaming Wizard is shown in 
Figure 26.

Figure 26. Broadcom Teaming Wizard Welcome Page

2. Click Expert Mode.

The New Team Configuration window opens, as shown in Figure 27 on 
page 54.

Figure 27. New Team Configuration

3. Type a team name in the Enter a name you will use to identify this 
team box. 
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Note
The number of characters that can be used in a team name is a 
minimum of 1 and a maximum of 39. 

Note
A team name cannot begin with spaces or contain the character "&". 

Note
Team names must be unique. If you attempt to use a team name 
more than once, an error message appears indicating that the name 
already exists. 

Note
The maximum number of members in a team is 8. 

Note
When team configuration has been correctly performed, a Virtual 
Team adapter driver is created for each configured team. 

4. Click the type of team and click Next. 
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The New Team Configuration window opens, as shown in Figure 28.

Figure 28. New Team Configuration Menu

5. Assign any available device or devices to the team by moving the 
device from the Available Adapters list to the Load Balance 
Members list. 

There must be at least one device in the Load Balance Members list. 

Note
There must be at least one Allied Telesyn Gigabit Ethernet adapter 
assigned to the team.

6. Click Finish. 

7. Click Apply. 

8. Click Yes when you see the message indicating that the network 
connection will be temporarily interrupted. 

Note
If you disable a virtual team and later want to reenable it, you must 
first disable and reenable all team members before you reenable the 
virtual team. 
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Note
When you create Generic Trunking and Link Aggregation teams, 
you cannot designate a Standby Member. Standby members work 
only with Smart Load Balance and Failover and SLB (Auto-Fallback 
Disable) types of teams. 

Note
For an SLB (Auto-Fallback Disable) team, when you want to restore 
traffic to the load balance members from the standby member, click 
the Fallback button on the Team Properties Tab. 

Note
Not all network devices made by other vendors are supported or 
fully certified for teaming.

9. Configure the Team IP address if necessary by choosing Start > 
Settings > the team name > Properties.

If other network devices in your computer use TCP/IP bindings, the 
TCP/IP Properties windows is displayed. 

10. Configure the IP address and any other necessary TCP/IP 
configuration for the team and click OK when finished. 

Modifying a
Team

After you have created a team, you can modify the team in the following 
ways:

Change the type of team 
Change the members assigned to the team 
Add a VLAN 
Remove a team or a VLAN 

To modify a team, perform the following procedure.

1. Select the team name.

2. From the Tools menu, click Configure a Team.

The Welcome page of the Broadcom Teaming Wizard is shown in 
Figure 11 on page 44.

3. Click Next.

The Team Name page asks for a name for the team, as shown in 
Figure 12 on page 44.

4. Type the name of the team you want to modify and click Next.
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The Team Properties tab is displayed with the properties of the team 
you selected, as shown in Figure 29.

Figure 29. Team Properties Tab

5. In the list of adapters in the team shown on the left, right-click the 
name of the team you want to modify and click Configure Team, Add 
VLAN, Configure LiveLink, or Fallback.

6. When you are done with your changes, click Apply. 

7. Click Yes when you see the message indicating that the network 
connection will be temporarily interrupted.

Adding a VLAN

You also can add VLANs to a team. The concept behind this is that you 
are adding multiple virtual adapters that are on different subnets. The 
benefit is that your server can have one network adapter that can belong 
to multiple subnets. With a VLAN, you can couple the functionality of load 
balancing for the Load Balance Members, and you can employ a failover 
adapter. 

You can define up to 64 VLANs per team (63 tagged and 1 untagged). 
VLANs can only be created when all members are Allied Telesyn 
adapters. If you try to create a VLAN with another type of adapter, an error 
message appears.
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Note
Disabled adapters are not recognized and they prevent the creation 
of a VLAN. If you attempt to create a VLAN with a disabled adapter, 
an error message is displayed.

To configure a team with a VLAN, perform the following procedure.

Note
To maintain optimum adapter performance, your system must have 
64 MB of system memory for each of the 8 VLANs created per 
adapter.

1. Select the team name.

The Team Properties tab opens as shown in Figure 25 on page 53.

2. In the list of adapters in the team shown on the left, right-click the 
name of the team you want to modify and click Add VLAN.

The Add VLAN dialog box opens, as shown inFigure 30 

Figure 30. Add VLAN Dialog Box

3. Type the VLAN ID and VLAN name, then click OK. 

The Untagged VLAN check box is exclusively used by the VLAN ID 
field. To use VLAN ID 0, simply click this check box. If you type a VLAN 
name or ID and the name already exists, an Input Error message 
appears.

4. When you are finished adding VLANs to this team, click OK. 

A new virtual adapter is created for each VLAN. 
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5. Click Apply. 

6. Click Yes when you see the message indicating that the network 
connection will be temporarily interrupted. 

The available adapters are listed (these adapters are not currently 
members of any team).

Displaying VLAN Properties and Statistics and Running VLAN Tests

The procedures in this section describe how to display VLAN properties 
and statistics as well as how to run VLAN tests and delete a VLAN. 

To display VLAN properties and statistics and to run VLAN tests, perform 
the following procedure.

1. In BACS2, click the VLAN name in the team’s Virtual Adapters folder, 
as shown in Figure 31.

Figure 31. VLAN Name Selected

2. Click the Vital Sign tab to view the properties of the VLAN adapter. 

3. Click the BASP Statistics tab to view the statistics for the VLAN 
adapter. 

4. Click the Network Test tab to run a network test on the VLAN adapter. 

To delete a VLAN, perform the following procedure.
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1. In BACS2, select the VLAN name in the team’s Virtual Adapters folder, 
as shown in Figure 31 on page 60.

2. Right-click the VLAN name and select click Remove VLAN. 

3. Click Apply. 

4. Click Yes when you see the message indicating that the network 
connection will be temporarily interrupted. 

Note
When you delete a team, the VLANs configured for that team are 
also deleted.

Saving and Restoring a Configuration

The configuration file is a text file that can be viewed with any text editor. 
The file contains information about both the adapter and the team 
configuration. To save and restore a configuration file, see the following 
procedures.

To save a configuration, perform the following procedure.

1. From the File menu, click Team Save As. 

The is Save As dialog box is shown in Figure 31.

Figure 32. Save As Dialog Box

2. Type the path and file name of the new configuration file and click 
Save (a .bcg extension is added). 

To restore a configuration, perform the following procedure.

1. From the File menu, click Team Restore. 
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The is Open dialog box is shown in Figure 31.

Figure 33. Save As Dialog Box

2. Click the name of the file to be restored and click Open. 

Note
You may need to navigate to the folder where the file is located.

If a configuration is already loaded, a message appears asking if you 
want to save your current configuration. Click Yes to save the current 
configuration. Otherwise, the configuration data that is currently loaded 
is lost. 

3. Click Apply to enable the Save Configuration feature.

Viewing the
Team Properties

and Statistics

To view the team properties and statistics, perform the following 
procedure.

1. Select the team name.

The Team Properties tab opens as shown in Figure 25 on page 53.
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Installing BACS on Windows 2000 and 
Windows 2003 Systems
This chapter provides procedures for installing the BACS application and 
configuring teaming on Windows 2000 and Windows 2003 systems. It 
contains the following sections:

“Installing the BASP” on page 64
“Uninstalling the BASP” on page 65
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Installing the BASP

For BASP installation procedures, refer to Chapter 2, “Broadcom 
Advanced Control Suite 2 (BACS 2) Applications” on page 19.
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Uninstalling the BASP

To uninstall the Broadcom Advanced Server Program Driver Properties 
(BASP), perform the following procedure:

1. Open the Control Panel

2. Double-click the Add or Remove Programs button.

3. Select Broadcom Management Programs and click Change/Remove.

4. Click Next. 

The InstallShield Wizard screen appears.

5. Click the Modify radio button and click Next.

6. The Select Components screen opens. 

Four install/uninstall selections are available from this screen. 

7. Deselect the BASP checkbox, then click Next.

8. A question box appears indicating that removing BASP will uninstall 
your configured adapter team/VLAN. Click Yes to continue.

9. When complete, an information screen notifies you that the files were 
successfully uninstalled. 

10. Click OK to complete the uninstall. 
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Chapter 4

Installing BACS on a Linux System
This chapter describes the installation and configuration of the BASP 
driver on Linux. It includes the following section:

“BASP Driver for Linux” on page 68
“Packaging” on page 69
“Installing BASP” on page 70
“Installing the BASP Source RPM Package for Red Hat and United 
Linux” on page 71

“Installing the BASP TAR Archive” on page 72
“BASP Files” on page 73
“BASP Configuration for Red Hat and United Linux Distributions” on 
page 74
“BASP Configuration and Startup for Other Linux Distributions” on 
page 76
“BASP Configuration Scripts for Red Hat Distributions” on page 78
“Broadcom NICE Patches” on page 79
“Uninstalling the RPM Package” on page 80
“Removal of Physical Interface in Generic Trunking and 802.3ad 
Mode” on page 81
“BASP SNMP Agent for Linux” on page 82
“Known Problems” on page 84
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BASP Driver for Linux

On newer Distributions and Kernels, it may be necessary to remove the 
BASP Driver for Linux

BASP is a kernel module designed for 2.4.x kernels that provides load-
balancing, fault-tolerance, and VLAN features. These features are 
provided by creating teams that consist of multiple NIC interfaces. A team 
can consist of 1 to 8 NIC interfaces and each interface can be designated 
as primary or hot-standby (SLB team only). All primary NIC interfaces in a 
team participate in Load-balancing operations by sending and receiving a 
portion of the total traffic. Hot-standby interfaces take over in the event 
that all primary interfaces have lost their links. In addition, VLANs can be 
added to a team to allow multiple VLANs with different VLAN IDs. A virtual 
device is created for each VLAN added.

There are three BASP modes:

SLB mode. This mode works with all Ethernet switches without 
configuring the switch ports to any special trunking mode. BASP 
supports Smart Load Balance (SLB™), Generic Trunking and IEEE 
802.3ad Link Aggregation. In SLB and 802.3ad modes, all NICE 
drivers must support Broadcom NIC Extension (NICE). 
Generic trunking mode. This mode does not require NICE and can 
work with any NIC; however, it requires the Ethernet switch to support 
the technology and be properly configured. This mode is protocol-
independent and all traffic should be load-balanced and fault-tolerant.
802.3ad mode. This mode requires NICE drivers and Ethernet 
switches supporting IEEE 802.3ad Link Aggregation. This mode is 
protocol-independent and all traffic is load-balanced and fault-tolerant. 
All the physical interfaces in the 802.3ad teams are defaulted to be 
LACP active. A 802.3ad team requires that all of the member NICs 
support NICE. All of the member NICs, once in the 802.3ad team, will 
be set with the same MAC address.

BASP also provides remote management through the SNMP protocol. 
This package is installed separately (see “BASP SNMP Agent for Linux” 
on page 82).
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Packaging

BASP is released in two packaging formats: source RPM and compressed 
tar formats. The file names for the two packages are basplnx-
<version>.src.<arch>.rpm and basplnx-<version>.<arch>.tgz. Identical 
source files to build the driver are included in both the RPM and TAR 
source packages.
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Installing BASP

BASP for Linux is shipped in mixed forms, where the platform and kernel 
specific files are in source code and the core file is in object form. Three 
packages are shipped in this release: two tar archives and two RPM 
packages.

basplnx-{version}.i386.tgz is the tar archive for i386 
platform.

For users of Red Hat or United Linux-based distributions, follow the 
instructions in “Installing the BASP Source RPM Package for Red Hat and 
United Linux” on page 71.

For users of other Linux i386 distribution, follow instructions in the 
“Installing the BASP TAR Archive” on page 72.
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Installing the BASP Source RPM Package for Red Hat and United 
Linux

To install the BASP RPM source package for Red Hat and United Linux 
1.x based distributions, perform the following procedure.

1. To install the RPM source package, run 

% rpm -i basplnx-{version}.src.{arch}.rpm

2. Change directory to the RPM path and build the binary driver for 
the kernel (use rpmbuild for Red Hat 8.0 or later) 

% cd /usr/src/{redhat or packages}
% rpm -bb SPECS/basplnx.spec or rpmbuild -bb SPECS/
basplnx.spec

Note
Each Linux distribution has a unique RPM path.

3. Install the newly built package 

% rpm -i RPMS/i386/basplnx-{version}.{arch}.rpm

The driver and other required files are installed automatically.

4. To load the driver

% insmod basp

5. To set up the teams, refer to “BASP Configuration for Red Hat and 
United Linux Distributions” on page 74.
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Installing the BASP TAR Archive

Use the procedures in this section to install Linux i386 distributions that 
are neither Red Hat nor United Linux distributions. Installing the BASP 
TAR archive involves both uncompressing the archive and then installing 
it.

To uncompress and expand the tar archive, run:

% tar xvfz basplnx-{version}.{arch}.tgz

To install the BASP TAR archive, perform the following procedure:

1. After extraction, change to the directory where the BASP source files 
are located. 

% cd basplnx-{version} 

2. To build a kernel module, "basp.o": 

% make

Note
The Make process automatically builds the correct module for 
different kernel options, for example, symbol versioning and SMP 
support. Do not define -DMODVERSIONS in the Makefile.

3. To create device file and to copy files: 

% make install

4. To update the module reference: 

% depmod -a

5. To load the driver: 

% insmod basp

6. To set up the teams, see “BASP Configuration and Startup for Other 
Linux Distributions” on page 76. 
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BASP Files

See Table 2 for a list of the BASP files.

Table 2. Contents of the release.txt File

Filename Description

Makefile makefile

baspcfg precompiled configuration utility

bcmtype.h commonly used type header file

blf.c BASP module entry points

blf.h ioctl interface

blfcore.h core interface

blfcore.o precompiled core object

blfopt.h automatically generated header file from 
the Make

blfver.h version header file

nicext.h NICE header file

pal.c platform abstraction implementation

pal.h header for platform abstraction

release.txt this file

nice-2.2.16 NICE enabled driver for 2.2 kernel

nice-2.4.16 NICE enabled driver for 2.4 kernel

scripts contains sample scripts

scripts/basp init script, goes to /etc/rc.d/init.d

scripts/baspteam start/stop script, goes to /etc/basp

scripts/baspif start/stop network, i/f, goes to /etc/basp

scripts/team-sample sample script of SLB team with three 
NICs

scripts/team-gec sample script of GEC team with three 
NICs

scripts/team-vlan sample script of SLB team with 2 VLANs

basp.4 man page
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BASP Configuration for Red Hat and United Linux Distributions

This section describes the BASP Configuration for Red Hat and United 
Linux 1.x based distributions. The BASP distribution includes a utility 
program and several scripts for team configuration. Most of the steps are 
only required after the first time installation. In the following procedure, 
perform Step 2 "Modify the configuration script," whenever you change the 
team configuration. 

Since Linux distributions do not automatically load drivers for network 
devices unless the device is configured with an IP address, you must 
manually configure a network-script file for all of the physical adapters that 
will be team members. Network script files are located under /etc/
sysconfig/network-scripts (Red Hat) or /etc/sysconfig/network (United 
Linux 1.x). The file name must be prefixed with "ifcfg-" then the physical 
adapter alias. For interface eth0, you create a file with the name ifcfg-eth0 
and then add the content below. 

Note
To avoid failover problems when using BASP, make sure that the 
spanning tree is disabled on the switch which is connected to the 
network adapter.

Note
When adding 64 VLANs, the 64th VLAN must have a VLAN ID of 0 
(63 VLANs are tagged and 1 VLAN is untagged).

Example: 

DEVICE=eth0
BOOTPROTO=static
ONBOOT=yes 

For users of other Linux distributions, follow instructions in the “BASP 
Configuration and Startup for Other Linux Distributions” on page 76.

baspcfg.8 man page for baspcfg utility

Table 2. Contents of the release.txt File (Continued)

Filename Description
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To configure BASP, perform the following procedure:

1. Copy a configuration script from the "/etc/basp/samples" directory to 
the "/etc/basp" directory. 

Note
The configuration script name must be prefixed with "team-".

2. Modify the following parameters of the configuration script:

(a) change the team type
(b) add or delete the physical network interfaces
(c) add or delete the virtual network interfaces
(d) assign IP address to each virtual network interface. 

The syntax of the configuration script can be found in “BASP 
Configuration Scripts for Red Hat Distributions” on page 78 or in the /
etc/basp/sample/team-sample script file itself. Note that when 
configuring Teaming, at least one Primary Adapter is required.

3. Manually start the team for the first time: 

% /etc/init.d/basp start

Note
This step is only required for the first time installation. The team 
configuration starts automatically on subsequent reboots.

Note
If not all of the virtual network interfaces are configured with an IP 
address, an error message is displayed when starting the BASP 
team. If this happens, repeat step 2 to configure an IP address for all 
of the virtual network interfaces. 

Note
Forming multiple teams is possible by copying the sample files into "/
etc/basp/team-<name>" and modifying this file as described in the 
sample file.

Note
To create more that one virtual interface (VLAN) for each team, refer 
to the respective description section in the sample files.
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BASP Configuration and Startup for Other Linux Distributions

BASP Configuration (baspcfg) is a command line tool that is used to 
configure the BASP teams, add/remove NICs, and add/remove virtual 
devices. This tool can be used in custom initialization scripts. Please read 
your distribution-specific documentation for more information on your 
distributor’s startup procedures. 

Following is an example of this tool:

baspcfg v3.0.14 - Broadcom Advanced Server Program 
Configuration Utility Copyright (c) 2000-2002 Broadcom 
Corporation. All rights reserved.

usage: baspcfg <commands>

commands

The commands are listed in Table 3.

where

The where options are listed in Table 4.

Table 3. Commands

Command Description

addteam <tid> <type> <tname> create a team

delteam <tid> delete a team

addva <tid> <vlan_id> 
<vname> [macaddr]

add a virtual adapter to a team

delva <tid> <vlan_id> delete a virtual adapter from a 
team

bind <tid> <role> <device> bind a physical adapter to a 
team

unbind <tid> <device> unbind a physical adapter from 
a team

show [tid] display team configurations

Table 4. Parameter Descriptions

Parameter Description

tid An unique ID for each team, 
starting from 0
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Note
You can only execute Baspcfg in Super User mode. Attempting to 
use baspcfg as a standard user displays the following error 
message, "Error in communicating to BASP Module. Is it loaded?".

When you configure Teaming, one Primary Adapter is required.

type Team type: 0=SLB, 1=FEC/
GEC, 2=802.3ad

tname ASCII string of the team

vlan_id VLAN ID: from 1 to 4094, 
0=untagged or no VLAN

vname ASCII string of the virtual 
device

macaddr MAC address (optional), for 
example, 00:10:18:00:11:44

role Role of the physical device: 
0=primary, 1=hot-standby

device ASCII string of the physical 
device, for example, eth0

Table 4. Parameter Descriptions (Continued)

Parameter Description
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BASP Configuration Scripts for Red Hat Distributions

Both team-sample and team-gec are configuration scripts that follow the 
same syntax. See Table 5 for more information.

Note
Teaming scripts are intended for Red Hat and United Linux-based 
distributions ONLY. Use with other Linux distributions may cause an 
error.

Table 5. Configuration Scripts

Script Description

TEAM_ID: this number uniquely identifies a 
team 

TEAM_TYPE: 0 = SLB, 1 = Generic Trunking/GEC/
FEC, 2 = 802.3ad 

TEAM_NAME: ascii name of the team 

TEAM_PAx_NAME: ascii name of the physical interface 
x, where x can be 0 to 7 

TEAM_PAx_ROLE: role of the physical interface x 0 = 
Primary, 1 = Hot-standby.
This field must be 0 for Generic 
Trunking/GEC/FEC team. 

TEAM_VAx_NAME: ascii name of the virtual interface x, 
where x can be 0 to 63 

TEAM_VAx_VLAN: 802.1Q VLAN ID of the virtual 
interface x.
For untagged virtual interface, that is, 
without VLAN enabled, set it to 0. 
The valid VLAN ID can be 0 to 4094. 

TEAM_VAx_IP: IP address of the virtual interface x. 
The format should be aa.bb.cc.dd. 

TEAM_VAx_NETMASK: Subnet mask of the virtual interface 
x. The format should mm.nn.oo.pp.
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Broadcom NICE Patches

Also included in this release are network device drivers patched with 
Broadcom NICE support. These drivers are originally taken from the Linux 
2.4.16 kernel distribution. 

To install patched drivers, perform the following procedure.

1. Copy the NICE header file, "nicext.h", to the appropriate Linux kernel 
include directory, for example:

% cp /usr/src/nice-2.4.16/nicext.h /usr/src/linux/
include/linux

2. Rename the original network device driver under the Linux kernel 
source tree, "/usr/src/linux/drivers/net".

3. Copy the patched drivers to the Linux kernel network driver source 
directory, i.e. "/usr/src/linux/drivers/net".

4. Follow the kernel rebuild instructions to configure kernel support for 
these drivers. 

% cd /usr/src/linux
% make config

5. If the patched drivers are configured into the kernel, go to step 7. If the 
patched drivers are configured as modules, go to step 6.

6. In the case of supporting only the module version of these drivers, it is 
possible to simply run the following to compile patched drivers and to 
install them into the proper module directory: 

% make modules
% make modules_install

There is no need to compile the complete kernel. Go to step 8.

7. Rebuild the kernel to compile these patched drivers:

% make clean 
% make dep 
% make

8. Either reboot the system or unload/load the patched modules. Run 
configuration scripts to test the patch. 
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Uninstalling the RPM Package

To uninstall a RPM package, perform the following procedure.

% rpm -e basplnx

and to reboot the system,

% reboot
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Removal of Physical Interface in Generic Trunking and 802.3ad Mode

In Generic Trunking and 802.3ad mode, all the physical and virtual 
interfaces belonging to a team have the same MAC address. This MAC 
address is the same address as that of the first physical interface bounded 
to the team. If the first physical interface is removed dynamically from the 
team using the "baspcfg" tool and bounded to the protocol directly, this 
could lead to a duplicate MAC address problem on the network. To 
properly remove a physical interface, perform the following procedure.

1. Back up the original team configuration script 

% cp /etc/basp/team-gec /etc/basp/backup-gec

Note
"team-gec" is the name of the configuration script.

Note
"backup-gec" is the name of the backup script. The name of the 
backup script must NOT be prefixed with "team-".

2. Modify the team configuration script to remove the physical interface.

3. Stop the running team.

% /etc/basp/baspif /etc/basp/backup-gec stop
% /etc/basp/baspteam /etc/basp/backup-gec del

4. Restart the team.

% /etc/basp/baspteam /etc/basp/team-gec add
% /etc/basp/baspif /etc/basp/team-gec start 
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BASP SNMP Agent for Linux

This SNMP agent is designed to support the configuration and statistics 
information pertaining to the BASP driver. The BASP SNMP agent is 
available in two packaging formats: TAR archive and RPM. Both packages 
include the same script and MIB files.

Installing the
TAR Archive

To uncompress and expand the tar archive, run:

% tar xvfz baspsnmp-{version}.tar

To install BASP SNMP agent for Linux, perform the following procedure.

1. Copy the getBaspInfo and genBaspTraps script files into /usr/bin 
directory.

2. Copy the BASP-Config-MIB.txt, BASP-Statistics-MIB.txt and Brcm-
BSAPTrap-MIB.txt into the /usr/share/snmp/mibs directory.

3. Locate the snmpd.conf file. 

It is usually located in one of the following directories: 

/etc/snmp 

/usr/lib/snmp 

$HOME/.snmp 

4. Add the following lines to the snmpd.conf.

pass .1.3.6.1.4.1.4413.1.2.1 /usr/bin/getBaspInfo
pass .1.3.6.1.4.1.4413.1.2.2.1 /usr/bin/getBaspInfo
pass .1.3.6.1.4.1.4413.1.2.2.2 /usr/bin/getBaspInfo
pass .1.3.6.1.4.1.4413.1.2.2.3 /usr/bin/getBaspInfo

5. Stop the snmpd daemon and restart it again. 

% /etc/init.d/snmpd stop
% /etc/init.d/snmpd start

6. Run the genBaspTraps script to allow monitoring of the BASP trap 
events:

% genBaspTraps 

This script can be terminated by hitting Ctrl-C keys if BASP trap event 
monitoring is no longer needed.
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7. The snmpget and snmpgetnext commands can be used to receive the 
BASP snmp objects such as:

% snmpget localhost public BASP-Config-MIB::btTeamNumber
% snmpgetnext localhost public BASP-Config-
MIB::btTeamNumber

BASP SNMP objects are provided in the following text files:

–  BASP-Config-MIB.txt 

–  BASP-Statistics-MIB.txt 

–  Brcm-BSAPTrap-MIB.txt 

Installing the
RPM Package

Complete the following steps to install BASP SNMP agent from the RPM 
package.

1. To install the RPM package, run:

% rpm -i baspsnmp-{version}.i386.rpm

The BASP script and MIB files are installed. The snmpd.conf 
configuration file is modified to add support for the BASP SNMP agent.

2. Follow steps 4 - 6 in the “Installing the TAR Archive” on page 82. 

Note
The current RPM installation fails to append the additional directives 
needed to the snmpd.conf file to support Basp objects. Therefore, 
follow the instruction (3) in the Install - TAR archive to modify the 
snmpd.conf file.

SNMP Files See Table 6 for a list of supported SNMP files.

Table 6. SNMP Files

Filename Description

genBaspTrap script monitoring the BASP trap events

getBaspInfo script to process SNMP get/getnext 
inquiries

BASP-Config-MIB.txt SNMP MIB file for BASP configuration 
objects

BASP-Statistics-
MIB.txt

SNMP MIB file for BASP statistics 
objects

Brcm-BSAPTrap-
MIB.txt

SNMP MIB file for BASP trap objects
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Uninstalling the
RPM Package

(Both Source and
Binary)

To uninstall RPM package, run:

% rpm -e baspsnmp-{version}.i386.rpm

and to reboot the system,

% reboot

Known Problems

The 802.3ad team member links disconnect and reconnect continuously 
when connected to the HP2524 switch. This is a 3rd party issue. It is seen 
only when configuring an 802.3ad team with more than 2 members on the 
server and connecting to an HP2524 switch, with LACP enabled as 
passive or active. The HP switch shows an LACP channel brought up 
successfully with only 2 members. All other member's links disconnect 
and reconnect. This issue does not occur with a Cisco Catalyst 6500. 

release.txt this file

Table 6. SNMP Files (Continued)

Filename Description
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Chapter 5

Key Protocols and Interfaces
This chapter describes the key protocols and interfaces. It contains the 
following sections:

“Adapter Teaming” on page 86
“Failover Teaming” on page 88
“VLANs Overview” on page 89
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Adapter Teaming

Teaming provides traffic load balancing and redundant adapter operation 
in the event that a network connection fails. When multiple Allied Telesyn 
adapters are installed in the same server, they can be grouped into teams. 
Each team can be configured on the server with up to 8 ports. If traffic is 
not identified on any of the adapter team members connections due to 
failure of the adapter, cable, switch port, or switch (where the teamed 
adapters are attached to separate switches), the load distribution is 
reevaluated and reassigned among the remaining team members. In the 
event that all of the primary adapters are down, the hot standby adapter 
becomes active. Existing sessions are maintained, causing no user 
impact.

BASP supports four schemes of load balancing: Smart Load Balancing, 
Link Aggregation (802.3ad), Generic Link Aggregation (Trunking), and 
Smart Load Balance Auto-Failback Disable. These schemes are 
described in the following sections.

Smart Load
Balancing

(SLB)™

The implementation of load balancing is based on IP flow. This feature 
supports balancing IP traffic across multiple adapters (that is, team 
members) in a bi-directional manner. In this mode, all adapters in the team 
have separate MAC addresses. It provides automatic fault detection and 
dynamic failover to other team members or to a hot standby member. This 
is done independently of the layer 3 protocol (IP, IPX, or Net Beui). It 
works with existing layer 2 and 3 switches.

Link Aggregation
(802.3ad)

This mode supports Link Aggregation and conforms to the IEEE 802.3ad 
(LACP) specification. Configuration software allows you to dynamically 
configure which adapters you want to participate in a given team. If there 
are 4 adapters in the system, you can select between 2 and 4 adapters to 
participate in the team.

If the link partner is not correctly configured for 802.3ad link configuration, 
errors are detected and noted. With this mode, all adapters in the team are 
configured to receive packets for the same MAC address. The outbound 
load-balancing scheme is determined by our BASP driver. The team’s link 
partner determines the load-balancing scheme for inbound packets. In this 
mode, at least one of the link partners must be in the active mode.

Generic Link
Aggregation
(Trunking)

This mode is very similar to 802.3ad in that you need to configure all of the 
adapters in the team to receive packets for the same MAC address. 
However, generic link aggregation mode does not provide LACP or 
marker protocol support. This mode supports a variety of environments 
where the NICs’ link partners are statically configured to support a 
proprietary trunking mechanism. For instance, this mode could be used to 
support Lucent’s "OpenTrunk" or Cisco’s Fast EtherChannel (FEC). 
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Basically, generic link aggregation mode is a "light" version of the 802.3ad 
link aggregation and is often referred to as 802.3ad static. This approach 
is much simpler because there is not a formalized link aggregation control 
protocol. As with the other modes, the creation of teams and the allocation 
of physical adapters to various teams is done statically via user 
configuration software.

Trunking supports load balancing and failover for both the outbound and 
inbound traffic.

Smart Load
Balance Auto-

Failback Disable

This team is almost identical to Smart Load Balance and Failover with one 
exception. If a primary member comes back on line when the standby 
member is active, the team continues using the standby member rather 
than switching to the primary member.
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Failover Teaming 

Failover Teaming provides a redundant adapter operation in the event that 
a network connection fails. When multiple Gigabit Ethernet Adapters are 
installed in the same server, they can be paired into teams. Each team 
must have at least one adapter, but can support up to eight adapters. The 
number of teams is limited by the number of adapters that are installed. 

If the primary adapter in a team is disconnected because the adapter, 
cable, or switch port fails, the secondary team member becomes active. In 
this case, the secondary team member redirects both the inbound and 
outbound traffic originally assigned to the primary adapter. Sessions are 
maintained; consequently, there is no impact to the user. 

Note
Allied Telesyn recommends disabling STP when you use the 
teaming and fault tolerance features.
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VLANs Overview

VLANs allow you to split your physical LAN into logical subparts, to create 
logical segmentation of workgroups, and to enforce security policies 
among each logical segment. Each defined VLAN behaves as its own 
separate network, with its traffic and broadcasts isolated from the others, 
increasing bandwidth efficiency within each logical group. Up to 64 VLANs 
(63 tagged and 1 untagged) can be defined for each Allied Telesyn Gigabit 
Ethernet adapter in your server, depending on the amount of available 
memory in your system. 

Although VLANs are commonly used to create individual broadcast 
domains and/or separate IP subnets, it is sometimes useful for a server to 
have a presence on more than one VLAN simultaneously. The 
adapters support multiple VLANs on a per-port or per-team basis, allowing 
very flexible network configurations. 

Figure 34. Example of Servers Supporting Multiple VLANs with Tagging 
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Figure 34 on page 89 shows an example network that uses VLANs. In this 
example network, the physical LAN consists of a switch, two servers, and 
five clients. The LAN is logically organized into three different VLANs, 
each representing a different IP subnet. The features of this network are 
described in Table 7. 

Table 7. Example VLAN Network Topology

Component Description

VLAN #1 An IP subnet consisting of the Main Server, PC #3, 
and PC #5. This subnet represents an engineering 
group.

VLAN #2 Includes the Main Server, PCs #1 and #2 via shared 
media segment, and PC #5. This VLAN is a software 
development group.

VLAN #3 Includes the Main Server, the Accounting Server and 
PC #4. This VLAN is an accounting group.

Main Server A high-use server that needs to be accessed from all 
of the VLANs and IP subnets. The Main Server has an 
Allied Telesyn adapter installed. All three IP subnets 
are accessed via the single physical adapter 
interface. The server is attached to one of the switch 
ports, which is configured for VLANs #1, #2, and #3. 
Both the adapter and the connected switch port have 
tagging turned on. Because of the tagging VLAN 
capabilities of both devices, the server is able to 
communicate on all three IP subnets in this network, 
but continues to maintain broadcast separation 
between all of them.

Accounting 
Server

Available to VLAN #3 only. The Accounting Server is 
isolated from all traffic on VLANs #1 and #2. The 
switch port connected to the server has tagging 
turned off.

PCs #1 and 
#2

Attached to a shared media hub that is then 
connected to the switch. PCs #1 and #2 belong to 
VLAN #2 only, and are logically in the same IP subnet 
as the Main Server and PC #5. The switch port 
connected to this segment has tagging turned off. 

PC #3 A member of VLAN #1, PC #3 can communicate only 
with the Main Server and PC #5. Tagging is not 
enabled on PC #3’s switch port.

PC #4 A member of VLAN #3, PC #4 can only communicate 
with the servers. Tagging is not enabled on PC #4’s 
switch port.
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Note
VLAN tagging is only required to be enabled on switch ports that 
create trunk links to other switches. It is also required on ports 
connected to tag-capable end-stations, such as servers or 
workstations with adapters.

VLANs Support Virtual Local Area Networks (VLANs) are commonly used to split up 
groups of network users into manageable broadcast domains, to create 
logical segmentation of workgroups, and to enforce security policies 
among logical segments. 

Each Team supports up to 64 VLANs. Note that only the Allied Telesyn 
adapters can be part of a team with VLANs. With multiple VLANs on an 
adapter, a server with a single adapter can have a logical presence on 
multiple IP subnets. With multiple VLANs in a team, a server can have a 
logical presence on multiple IP subnets and benefit from load balancing 
and failover. 

Note
Adapters that are members of a failover team can also be configured 
to support VLANs. 

Adaptive
Interrupt

Frequency

Based on traffic conditions, the adapter driver intelligently adjusts host 
interrupt frequency to increase overall application throughput. When traffic 
is light, the adapter driver interrupts the host for each received packet, 
minimizing latency. When traffic is heavy, the adapter issues one host 
interrupt for multiple, back-to-back incoming packets, preserving the host 
CPU cycles. 

Dual DMA
Channels

The PCI interface on the Gigabit Ethernet Adapter contains two 
independent DMA channels for simultaneous read and write operations. 

PC #5 A member of both VLANs #1 and #2, PC #5 has an 
Allied Telesyn adapter installed. It is connected to 
switch port #10. Both the adapter and the switch port 
are configured for VLANs #1 and #2 and have tagging 
enabled.

Table 7. Example VLAN Network Topology (Continued)

Component Description
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32-bit or 64-bit
PCI Bus Master

Compliant with PCI Local Bus Rev 2.2, the PCI interface on the Gigabit 
Ethernet Adapter is compatible with both 32-bit and 64-bit PCI buses. As a 
bus master, the adapter requests access to the PCI bus, instead of waiting 
to be polled. 

ASIC with
Embedded RISC

Processor

The core control for the Gigabit Ethernet Adapter resides in a tightly 
integrated, high-performance ASIC. The ASIC includes dual RISC 
processors. This provides the flexibility to add new features to the card 
and adapt it to future network requirements via a software download. This 
also enables the adapter drivers to exploit the built-in host offload 
functions on the adapter as host operating systems are enhanced to take 
advantage of these functions. 
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Chapter 6

Troubleshooting
This chapter describes troubleshooting procedures and contains the 
following sections:

“Verifying the Correct Drivers are Loaded” on page 94
“Software Problems and Solutions” on page 96
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Verifying the Correct Drivers are Loaded

The following section describes how to check if the correct drivers are 
loaded for Windows and Linux.

Windows The Broadcom Advanced Control Suite, Vital Sign tab allows you to view 
vital adapter information, network status, and network connectivity. Active 
adapters are listed on the Vital Sign tab.

1. On the Vital Sign tab, select the adapter you want to test. 

2. Press Refresh to display the driver status of the selected adapter. 

Note
The information for other adapters is less comprehensive than the 
information listed for an Allied Telesyn Gigabit Ethernet adapter.

Figure 35. Vital Sign Tab, Troubleshooting
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Linux

To verify that the Linux Driver software is loaded correctly, perform the 
following procedure.

1. To verify that the bcm5700.o driver is loaded properly, run:

lsmod 

If the driver is loaded, a line similar to the one below appears, where 
<size> is the size of the driver in bytes, and <n> is the number of 
adapters configured, as shown in Table 8.

Table 8. Linux Driver Software Information

Module Size Used by

BCM5700 <size> <n>
95

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 6: Troubleshooting
Software Problems and Solutions

This section describes common software problems and solutions and 
contains the following subsections:

“Windows 2000” on page 96
“Linux-BASP” on page 97
“Broadcom Advanced Server Program (BASP)” on page 98

Windows 2000 This section lists known problems and solutions when using Windows 
2000. 

Problem: When uninstalling the BASP software, you are prompted to 
reboot early.

Solution: After configuring a BASP team, the Windows 2000 system may 
sometimes prompt you to reboot. This is because Plug and Play on W2k 
may fail to commit any change in the network protocol binding. You can 
choose not to reboot and continue configuring the intermediate driver 
without causing any side effects. When you have finished the 
configuration, you must reboot the system. 

Problem: Cannot enable VLAN after it is disabled.

Solution: The BASP application creates additional network connections in 
the "Network Connection and Dial-up" Window. Similar to physical 
network connections, these virtual connections can be disabled via the 
context menu. However, if these virtual connections are re-enabled, the 
system reports a "connection failed!" error. This is a known problem with 
the Windows 2000 system. When this happens, rebooting the system 
reenables the virtual connection. 

Problem: Able to configure Internet Connection Sharing (ICS) when there 
aren't any unassigned adapters. 

Solution: Windows 2000 networking is shipped with the Internet 
Connection Sharing (ICS) application, which is designed to allow multiple 
computers to access the Internet via a Windows 2000 system. To 
configure the ICS application, you need to select a network connection as 
an "outside" connection and another network connection as an "inside" 
connection. However, the ICS application allows you to select any 
available network connection as an "outside" or "inside" connection, 
regardless of the BASP team configuration. Allied Telesyn recommends 
that you do not select any network connection that is part of the BASP 
team to be "outside" or "inside."
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Problem: Team configuration is not retained when you edit it.

Solution: In configuring BASP team configuration, the actual changes of 
the configuration are not committed until you click "OK" in the "Network 
Properties" window. If you do not click "OK" and, instead, return to the 
BASP team configuration window, all the previous uncommitted changes 
are lost. This requires you to reenter the configuration. As a workaround, 
always click "OK" in the "Network Properties" window after making 
changes.

Problem: IP address is configurable on a member of the team. 

Solution: When a team is created, the TCP/IP properties for the adapters 
are unselected. You can select and configure the TCP/IP properties of the 
adapters and configure an IP address manually. This issue is a limitation 
of the Windows 2000 network installation paradigm where this invalid 
configuration is still allowed. 

Problem: When creating 64 VLANs, all virtual adapters are displayed as 
disconnected or one of the 64 VLANs is displayed as disabled.

Solution: The maximum VLAN configurations are 63 tagged and one 
untagged VLAN ID 0. If 64 tagged VLANs are created, they are 
disconnected. A reboot is required and only the 63 tagged VLANs show 
links, while the 64th VLAN is disabled. 

Linux-BASP This section lists known problems and solutions using Linux-BASP.

Problem: When obtaining the IP for a SLB's virtual interface via DHCP, 
the IP-gets lost under heavy traffic. 

Solution: Always set a static IP for all the virtual interfaces in a SLB team. 

Problem: Make install fails on Turbo Linux 7.0 IA64.

Solution: The symbolic link under /lib/modules/<kernel-version>/build 
points to an empty directory. To successfully install BASP using `make 
install`, re-link /lib/modules/<kernel-version>/build to point to /usr/src/
<kernel-version>/. 
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Broadcom
Advanced Server
Program (BASP)

This section lists known BASP problems and solutions that apply to all 
operating systems.

Problem: 802.3ad team member links disconnect and reconnect
continuously.

Solution: This is a 3rd party issue. It is seen only when configuring an 
802.3ad team with more than 2 members on the server and connecting an 
HP2524 switch, with LACP enabled as passive or active. The HP switch 
shows an LACP channel being brought up successfully with only 2 
members. All other member's links disconnect and reconnect.

Note
This issue does not occur with a Cisco Catalyst 6500. 
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Chapter 7

Manageability Features
This chapter describes the magageability features and contains the 
following sections:

“CIM” on page 100
“SNMP” on page 101
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CIM

The Common Information Model (CIM) is an industry standard defined by 
the Distributed Management Task Force (DMTF). Microsoft implements 
CIM on Windows platforms such as Windows 2000 and Windows Server 
2003 systems. Allied Telesyn supports CIM on the Windows 2000 and the 
Windows Server 2003 platforms. 

Allied Telesyn's implementation of CIM provides various classes that 
provide information to users through CIM client applications. (Please note 
that the Broadcom CIM data provider provides data only.) You can choose 
your preferred CIM client software to browse the information provided by 
the Broadcom CIM provider. 

The Broadcom CIM provider provides information through the 
BRCM_NetworkAdapter and BRCM_ExtraCapacityGroup classes. 
The BRCM_NetworkAdapter class provides network adapter information 
pertaining to a group of adapters including the adapter and other vendors’ 
controllers. The BRCM_ExtraCapacityGroup class provides team 
configuration for the BASP feature. Current implementation provides team 
information as well as information about physical network adapters in the 
team. 

BASP provides events through event logs. You can use the Event Viewer 
provided by Windows 2000 and Windows Server 2003. Or, you can use 
CIM to inspect or monitor these events. BASP provider also provides 
event information through the CIM's generic event model. These events 
are __InstanceCreationEvent, __InstanceDeletionEvent and 
__InstanceModificationEvent. These events are defined by CIM. In 
addition, CIM requires the client application to register the events from the 
client application, using queries as examples (shown below) in order to 
receive events properly. 

SELECT * FROM __InstanceModificationEvent where 
TargetInstance ISA "BRCM_NetworkAdapter"
SELECT * FROM __InstanceModificationEvent where 
TargetInstance ISA "BRCM_ExtraCapacityGroup"
SELECT * FROM __InstanceCreationEvent where 
TargetInstance ISA "BRCM_NetworkAdapter"
SELECT * FROM __InstanceDeletionEvent where 
TargetInstance ISA "BRCM_NetworkAdapter"
SELECT * FROM __InstanceCreationEvent where 
TargetInstance ISA "BRCM_ActsAsSpare"
SELECT * FROM __InstanceDeletionEvent where 
TargetInstance ISA "BRCM_ActsAsSpare"

For detailed information about these events, please refer to the CIM 
documentation. 
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SNMP

There are two SNMP agents for manageability:

BASP Sub-agent
BASP Extensible-agent

See the following sections.

BASP Sub-agent The BASP sub-agent, baspmgnt.dll, is designed for the Windows 2000 
and Windows Server 2003 SNMP service. It is required to install the 
SNMP service before installing BASP subagent. 

The BASP subagent allows the SNMP manager software to actively 
monitor the configurations and performance of the BASP features. The 
subagent also provides an alarm trap to an SNMP manager to inform the 
manager of any changes to the conditions of the BASP component. 

The BASP subagent allows monitoring of the configurations and statistics 
for the BASP teams, the physical NIC adapters participating in a team, and 
the virtual NIC adapters created as the result of teaming. The BASP 
configuration data includes information such as team IDs, physical/virtual/
VLAN/team adapter IDs, physical/virtual/VLAN/team/ adapter descriptions, 
and MAC addresses of the adapters. 

Note
Non-teamed NIC adapters are not monitored at this time

The statistics include detailed information such as data packets 
transmitted and received for the physical/virtual/VLAN/team adapters. 

The alarm trap forwards information about configuration changes to the 
physical adapters participating in a team, such as physical adapter link up/
down and adapter installed/removed events.

To monitor this information, an SNMP manager needs to load the 
BASP MIB database files to allow monitoring of the information described 
above. These files are shown below: 

baspconfig.mib
baspstat.mib
basptrap.mib
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BASP Extensible-
agent

The Broadcom SNMP extensible-agent, bcmif.dll, is designed for the 
Windows 2000 and Windows Server 2003 SNMP service. The software 
requires that a Windows 2000 SNMP service is installed before installing 
the extensible-agent.

The extensible-agent allows the SNMP manager software to actively 
monitor the configurations of the Interface Card. It is intended to 
supplement the information already provided by the standard SNMP 
Management Network Interface information.

The extensible-agent provides in-depth information about an Allied 
Telesyn adapter, such as: 

MAC address
bound IP address
IP subnet mask
physical link status
adapter state
line speed
duplex mode 
memory range
interrupt setting
bus number
device number
function number

To monitor the information listed above, a SNMP manager needs to load 
the MIB file. 

The monitored workstation requires the installation of the Broadcom 
SNMP extensible-agent, bcmif.dll, and requires that the Microsoft 
Windows 2000 or Windows Server 2003 SNMP service be installed and 
loaded.
102

Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
h�p://myh66.com

h�p://usermanuals.us
h�p://www.somanuals.com

h�p://www.4manuals.cc
h�p://www.manual-lib.com
h�p://www.404manual.com
h�p://www.luxmanual.com

h�p://aubethermostatmanual.com
Golf course search by state

h�p://golfingnear.com
Email search by domain

h�p://emailbydomain.com
Auto manuals search

h�p://auto.somanuals.com
TV manuals search

h�p://tv.somanuals.com

http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

	Contents
	Figure 1. Advanced Control Suite 2 Menu 20
	Figure 2. Vital Sign Tab 28
	Figure 3. Resources Tab 30
	Figure 4. Hardware Tab 31
	Figure 5. Advanced Tab 32
	Figure 6. Network Test Tab 36
	Figure 7. Diagnostics Tab 37
	Figure 8. Statistics Tab 38
	Figure 9. BASP Statistics Tab 41
	Figure 10. New Team Configuration Window 42
	Figure 11. Broadcom Teaming Wizard Welcome Page 44
	Figure 12. Team Name Page 44
	Figure 13. Team Type Page 45
	Figure 14. Assigning Team Members Page 46
	Figure 15. Team Member Selection 47
	Figure 16. Team Standby Member Page 47
	Figure 17. Standby Member Selection 48
	Figure 18. Configuring LiveLink Page 49
	Figure 19. Configure VLAN Support Page 49
	Figure 20. VLAN Naming Page 50
	Figure 21. VLAN Tagging Page 51
	Figure 22. Additional VLANs Page 52
	Figure 23. Final Teaming Wizard Page 52
	Figure 24. Commit Changes Warning Message 53
	Figure 25. Team Properties Tab 53
	Figure 26. Broadcom Teaming Wizard Welcome Page 54
	Figure 27. New Team Configuration 54
	Figure 28. New Team Configuration Menu 56
	Figure 29. Team Properties Tab 58
	Figure 30. Add VLAN Dialog Box 59
	Figure 31. VLAN Name Selected 60
	Figure 32. Save As Dialog Box 61
	Figure 33. Save As Dialog Box 62
	Figure 34. Example of Servers Supporting Multiple VLANs with Tagging 89
	Figure 35. Vital Sign Tab, Troubleshooting 94

	Figures
	Table 1. BACS Application Information 21
	Table 2. Contents of the release.txt File 73
	Table 3. Commands 76
	Table 4. Parameter Descriptions 76
	Table 5. Configuration Scripts 78
	Table 6. SNMP Files 83
	Table 7. Example VLAN Network Topology 90
	Table 8. Linux Driver Software Information 95

	Tables
	Preface
	Where to Find Web-based Guides
	Contacting Allied Telesyn
	Online Support
	Email and Telephone Support
	Returning Products
	Sales or Corporate Information
	Management Software Updates


	Chapter 1
	Advanced Server Program Overview
	Broadcom Advanced Server Program (BASP) Overview
	Broadcom Advanced Control Suite 2 (BACS 2) Features
	BASP for Windows 2000 and Windows 2003
	Failover and Load Balance
	Virtual LAN (VLANs)

	BASP for Linux
	Failover and Load Balance
	Virtual LAN (VLAN)


	Chapter 2
	Broadcom Advanced Control Suite 2 (BACS 2) Applications
	Overview
	Information Provided by the BACS 2 Applications
	BACS 2 Features

	Installing the BACS 2 Application
	Installing Using the GUI
	Using Silent Installation
	1. Type setup /s and press ENTER.


	Managing the BACS Application
	Initializing the BACS 2 Application
	1. In the Control Panel, double-click Broadcom Control Suite 2.

	Updating the BACS Application
	1. Double-click Setup.exe.

	Removing the BACS Application
	1. In the Control Panel, double-click Add/Remove Programs.


	Configuring the BACS 2 Application
	Vital Sign Tab
	Resources Tab
	Hardware Tab
	Advanced Tab
	Network Test Tab
	Diagnostics Tab
	Statistics Tab
	BASP Statistics Tab

	Configuring Teaming
	Creating a Team Using the Wizard
	1. From the Tools menu, click Create a Team.

	Creating a Team Using the Expert Mode
	1. From the Tools menu, click Create a Team.

	Modifying a Team
	1. Select the team name.
	1. Select the team name.
	1. In BACS2, click the VLAN name in the team’s Virtual Adapters folder, as shown in Figure 31.
	1. In BACS2, select the VLAN name in the team’s Virtual Adapters folder, as shown in Figure 31 on page 60.
	1. From the File menu, click Team Save As.
	1. From the File menu, click Team Restore.

	Viewing the Team Properties and Statistics
	1. Select the team name.



	Chapter 3
	Installing BACS on Windows 2000 and Windows 2003 Systems
	Installing the BASP
	Uninstalling the BASP
	1. Open the Control Panel


	Chapter 4
	Installing BACS on a Linux System
	BASP Driver for Linux
	Packaging
	Installing BASP
	Installing the BASP Source RPM Package for Red Hat and United Linux
	1. To install the RPM source package, run

	Installing the BASP TAR Archive
	1. After extraction, change to the directory where the BASP source files are located.

	BASP Files
	BASP Configuration for Red Hat and United Linux Distributions
	1. Copy a configuration script from the "/etc/basp/samples" directory to the "/etc/basp" directory.

	BASP Configuration and Startup for Other Linux Distributions
	BASP Configuration Scripts for Red Hat Distributions
	Broadcom NICE Patches
	1. Copy the NICE header file, "nicext.h", to the appropriate Linux kernel include directory, for example:

	Uninstalling the RPM Package
	Removal of Physical Interface in Generic Trunking and 802.3ad Mode
	1. Back up the original team configuration script

	BASP SNMP Agent for Linux
	Installing the TAR Archive
	1. Copy the getBaspInfo and genBaspTraps script files into /usr/bin directory.

	Installing the RPM Package
	1. To install the RPM package, run:

	SNMP Files
	Uninstalling the RPM Package (Both Source and Binary)

	Known Problems

	Chapter 5
	Key Protocols and Interfaces
	Adapter Teaming
	Smart Load Balancing (SLB)™
	Link Aggregation (802.3ad)
	Generic Link Aggregation (Trunking)
	Smart Load Balance Auto- Failback Disable

	Failover Teaming
	VLANs Overview
	VLANs Support
	Adaptive Interrupt Frequency
	Dual DMA Channels
	32-bit or 64-bit PCI Bus Master
	ASIC with Embedded RISC Processor


	Chapter 6
	Troubleshooting
	Verifying the Correct Drivers are Loaded
	Windows
	1. On the Vital Sign tab, select the adapter you want to test.
	1. To verify that the bcm5700.o driver is loaded properly, run:


	Software Problems and Solutions
	Windows 2000
	Linux-BASP
	Broadcom Advanced Server Program (BASP)


	Chapter 7
	Manageability Features
	CIM
	SNMP
	BASP Sub-agent
	BASP Extensible- agent




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


